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1  Software help 
 
1.1  Accreditation Application overview 
 
The Accreditation application software ('software') allows data entry for details about the approved provider and the 
homes associated with the self-assessment of the expected outcomes of the Accreditation Standards. 
 
Your responses to questions are saved locally on your hard disk or on a server if the network version is activated. 
You may start and stop as many times as you wish. The software 'remembers' how and where you last left the 
application and re-opens at that place for further input. 
 
In this document; the word 'Application' refers to the submission of information required to achieve accreditation, 
the word 'Software' refers to this software which provides a vehicle to collect the accreditation application 
information. 
 
1.2  Starting to use the electronic application 
 
When the Software first opens, a Standards navigation panel is seen in the top left hand corner. A single click on a 
Standard will navigate to the first expected outcome in that Standard.  
 
Clicking a Standard will also expand the expected outcomes associated with that standard, and as you click on each 
expected outcome the respective answer for each expected outcome will show on the screen.  
 
Navigation through the expected outcomes can be achieved via the Back and Forward buttons on the tool bar 
(under the main menu). 
 
The application comprises 39 unique self-assessment prompts to the expected outcomes. Self assessment prompts 
to .1, .2 and .3 expected outcomes are common to all four Standards. 
 
Each Standard has an "Overall Approach" where there is an opportunity to describe the process you use in the 
home to achieve the expected outcomes within the Standard. Individual expected outcomes each have a Yes/No 
question associated with them, which is a declaration as to whether the information supplied demonstrates 
achievement. 
 
1.3  Upgrading to Version 3 
 
With the exception of computers with Vista operating systems (see below), Version 3 of the software will install into 
the same directory as the previous versions. You have already been advised to take a backup of your database 
before this upgrade. 
 
You area also advised to backup and restore your database after the new version has been installed. 
 
Simply select File/Backup and once completed, select File/Restore. You will be prompted to select the backup file 
which will be in the BackupData folder and will have been named with a date stamp suffixed to the filename e.g. 
this backup - acsaa2008-6-11-11-48-53.fbk - was created on 11 June 2008 at 11:48AM. 
 
Once restored, the application will prompt you to switch to the restored file, agree to this suggestion. That's all 
there is to the upgrade. 
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Vista operating system 
 
For users who have previously installed Version 2 on Microsoft Vista, please follow these 
instructions: 
Version 2 of this application software is not supported on Vista. 
It is possible to install Version 2 on Vista but if you have done so, you will need to follow these instructions to 
carefully remove the previous version and then install this new Version 3. 
 

Version 2 installed the database file to this path C:\Program Files\ACSAA\CurrentData. 
This location has restricted access under Vista which forces the creation of a virtual location for the database here: 
C:\Users\[yourusername]\AppData\Local\VirtualStore\Program Files\ACSAA\CurrentData 
(Similar locations were created for BackupData, ImportData and ExportData). 
 

To safely upgrade to Version 3, you must: 
1  Backup the current database using the menu options, 
2  Locate this file and move it to a safe place for later restoration, 
3  Uninstall Version two 
4  Remove all directories which may have been created by the Version 2 installation 
5  Install Version three 
6  Restore the previous backup (step 1 and 2)  
 

1  Backup 
Use the main menu option to Backup the database. The last line of the backup dialog will confirm the position of 
this backup file in the form. 
C:\Program Files\ACSAA\BackupData\acsaayyyy-m-dd-hh-mm-ss.fbk 
But this file will actually be in this location. 
C:\Users\[yourusername]\AppData\Local\VirtualStore\Program Files\ACSAA\BackupData\acsaayyyy-m-dd-hh-mm-
ss.fbk. 
(where yourusername  is your windows login username and the file name will be in the date and time of the 
backup). 
 

2  Save the Backup File 
Using windows explorer, locate the file described above and copy and paste it into your documents directory. 
 

3  Uninstall Version 2 
This may require administrator access (as per the installation procedure). 
 

4  Remove existing folders 
Now you must completely delete the ACSAA folder which is inside the 
C:\Users\[yourusername]\AppData\Local\VirtualStore\Program Files folder. 
Delete all sub folder but you must leave the folder 
C:\Users\[yourusername]\AppData\Local\VirtualStore\Program Files\ 
in place. 
You must also delete the ACSAA folder and sub folders which are inside the  
C:\Program Files\ folder. 
 

You may be asked for administrator rights to remove these folders. 
 

5  Install Version three 
Install the new version as normal. You may be asked to supply administrator permission to achieve the installation. 
 

6  Restore Backup 
Restore the previous backup in step 1 and 2 above. 
From the main menu, select File/Restore and browse to the backup file you moved to the Documents directory, 
select it and click Open. 

Confirm that you wish to switch to the restored database and close the restore dialog. 
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1.4  Preferences 
 

1.4.1  Paths and Settings 
 

The Program Directory cannot be edited. This path merely confirms the execution path for the software currently 
running. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The default paths created during installation are as follows: 
 

Import Directory: C:\Program Files\ACSAA\ImportData 
Export Directory: C:\Program Files\ACSAA\ExportData 
 

Local Database Path and Filename: acsaa 
Remote Database Path 7 Filename: acsaa 
In both these cases, acsaa if an alias for the full path to the database file. Refer Configuring the Server for more 
details on the aliases.conf file. 
 

Server name: left blank by default. This field will need to refer to the name of the server where the Firebird 
server is located on your network. This field is ignored when "Use remote Server" is not checked and is only 
relevant to where the network version is activated. In the example above, the server name does not contain a 
custom port e.g. "/3051". This is not required where the default port is used which is the default setting for the 
server installation. Please contact support if you already have Interbase RDBMS installed and you wish to install 
Firebird on the same machine. To permit this, a custom port will need to be configured for the Firebird service. 
 

When you edit the remote settings on this tab sheet, it is necessary to use the test connection button to ensure 
you have made the correct settings and the server is running. Once a successful connection is detected, you will 
be prompted to switch over to the new connection if you wish. 
 

The new version 3 of the software places the data files into the users profile, instead of in program files 
subdirectories. If you wish to follow this convention, the Restore Defaults option will replace the existing path for 
Export and Backup folders with the new paths to your user's profile Application Data/ACSAA folder. This change 
will not effect your existing local database path and filename. You will need to move that manually if you wish to 
do so. 
 

1.4.2  Desktop 
 

Session settings are localised preferences which are saved to a local folder on your hard disk. Under certain 
system setups, users are given limited permissions over their PC and only certain folders are provided for users to 
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save information. In such situations, both the session settings and the database file requires to be resident in a 
folder where write permissions have been granted. This directory setting is provided for this purpose. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When applications are exported and imported, temporary files are created before archiving or compressing them 
in a zip file. If you are ever asked to do so, you may be asked by support staff to uncheck the cleanup 
temporary files during this operation and forwarding the temporary files. This option is checked by default and 
can remain checked for best performance. 
 
When using the File/Submit Application menu, a successful answer check and export of the application will 
terminate with a dialog prompting to gather support documentation. By default, when this dialog is dismissed, the 
software will call the default email client and prepare an email message ready for submission. You will still be 
required to insert file attachments including the exported answer set to this email. 
 
In the case where the default email client is not set on the PC, this operation may cause an error. This preference 
setting if provided for such a case. By unchecking this "Automatically create email" checkbox, the email will 
not be created and it will be left to the user to manually create this email for submission. 
 
 
Colours 
To assist in the navigation process, each standard is color coded. For some PCs the video card may not be able to 
show the default colors. In this instance, the user may select another color to aid recognition. 
 
The default colors can be re-selected at any time by clicking the "Default" button. 
 
1.4.3  Saving and Backup 
 
By default, your work is saved every five minutes while the application software is running. You may still save 
your work manually at any time. 
The software has a feature where recent edits (since the last save) can be cancelled. While auto save is 
operating, the cancel feature may have little or no effect because the time since the last save is quite short. If a 
user wishes to use the cancel edits feature more exhaustively, this Auto-Save timer can be switched off. 
Please be aware, however, that while using the software in network mode, switching auto-save off may produce 
lock conflicts with other users, since the time between saves for your work may be longer than desirable. 
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By default, backups are left for the user to do manually when desired. For standalone mode, backups can be made to 
occur each time the software is exited. Under these circumstances, backups are cycled up to a maximum of 10 files 
before the oldest is again overwritten by a recent backup. 
 

You may choose to have the software warn you when your file count is reached. You may also set the system to 
ignore the file count completely and always make a backup of the file. 
Please be aware that Ignore backup file count completely can lead to large volumes of hard disk space being 
consumed. 
 

A separate directory can be configured to capture the backup files. This directory can be a network share to ensure 
that the backup file is included in nightly system backups is your system provides such a feature. 
 

Warning: Do not restore a backup to a network share and expect multiple users to access the file via this method. If 
multiple users are to be configured, install the server software and run the application software in network mode. 
 

1.4.4  Server info 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Only when the software is operating in network mode, will the Server Info table be visible. The information here is for 
support personnel only. You may be asked to provide information from this tab. 
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1.5  Server setup 
 
1.5.1 First steps 
 
In the following topics we will deal with: 

• Choose a suitable server PC 
• Downloading the server software 
• Installing the server software 
• Configuring to server 
• User security 
• Testing the server 
• Connecting to the server 

 
There are a few of things which need to be attended to in making the ACSAA application software work correctly 
in network mode. Some refer to the recommended installation of Firebird, some relate to slight modifications to 
the default setup which will enhance the useability of the software. 
 
 
A suitable PC for the server 
 

Select a suitable PC for the server function. We recommend the preferred specification here: 
For Windows: Windows NT4 Server SP6a, Windows Professional Server 2000, Windows Server 2003 
For Linux flavours: Redhat 8 or 9, Fedora, or any other flavour of Linux you prefer. 
For Both operating systems, remember that more memory you have on the PC the better. More RAM is always 
better than faster CPU speed. 
 

A minimum specification would be: 
For Windows: Windows NT4 Workstation Sp6a. Desktop flavours of Windows. e.g 95, 98 are not the best 
choice, they do not support Services and as such it is required that Firebird be installed as an Application which 
less desirable, less stable and less reliable. That said, the decision is yours. Just remember that when Firebird is 
run as an application, someone, usually the normal user of the PC in question will be required to start the Firebird 
server and should also leave it running until you are quite sure no one is using the ACSAA Application software. 
 

1.5.2 Downloading the server 
 

The Firebird Relational Database Server is an Open Source project. This means that it is provided free of license 
fees to whoever wishes to use it. It can be used for both commercial and non-commercial purposes. 
 

The Server software can be downloaded from http://www.firebirdsql.org, select Downloads / Firebird Relational 
Database and go half way down the page. Or just click this link for the download. Save the file and when it has 
finished downloading, click on it to start the installation. 
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Please read this information in detail. This information is particularly relevant where you already have a version of 
Interbase or Firebird installed on the PC and, most importantly, if you have a Firebird or Interbase server 
currently running. 
 
 

After you have chosen the directory in which to install the server, you will be presented with a choice of 
components. 
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Please select super server binary for the install (the default) and leave selected, the server components, 
developer and admin tools and client components selected. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Assuming that you are installing on an operating system which will support services, please ensure the defaults 
are accepted.  

• Use the Guardian which will keep an eye on the Firebird service and re-start it if it should ever stop by 
accident. 

• Run the server as a Service 
• Start Firebird automatically 
• You may accept the default of generating a client library if you wish, ACSAA comes with its own copy which 

is also the embedded server so you won't need this file. 
• Install the control panel 
• Now complete the installation 
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When the installation is finished, you can accept to start the Server. You will now need to follow a few more steps 
to customise the setup to work correctly with ACSAA. The customisations listed here will not alter Firebird's ability 
to perform other tasks you may have planned for it. 
 
1.5.3 Configuring the Server 
 
There are a couple of enhancements to be carried out on the server installation to make things a little easier for 
use with the ACSAA software. The customisations listed here will not alter Firebird's ability to perform other tasks 
you may have planned for it. 
 
You will need to do the following: 
 1 Stop the Server 
 2 Edit the aliases.conf file 
 3 Rename the existing security.fdb file and copy over the one included with the ACSAA installation 
 4 Copy over 3 files from the ACSAA software installation directory 
 5 Restart the server 
 
1  Stop the Server 
Open the Control Panel applet Firebird 2.1 Server Manager. 
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Now click the Stop button to stop the server. 
 

2  Edit the aliases.conf file 
In the directory you chose to install the Firebird server (e.g. C:\Program Files\Firebird\Firebird_2_1) you will find a 
file named aliases.conf. 
Open this file in Notepad. (Do not use MS Word or any other word processing package). 
 

#  
# List of known database aliases  
# ------------------------------  
#  
# Examples:  
#  
#   dummy = c:\data\dummy.fdb  
#   

 
The contents will look like the above. 
Now add a line at the bottom 
   acsaa = c:\acsaadata\acsaa.fdb  

 
So the file now looks like this 
 
#  
# List of known database aliases  
# ------------------------------  
#  
# Examples:  
#  
#   dummy = c:\data\dummy.fdb  
#   
   acsaa = c:\acsadata\acsaa.fdb  
 

Create a directory you wish to use for storing the acsaa database, and  
Add a line in the configuration file to reflect this directory and file.  
The last line added does not have a hash character which denotes a comment line. 
Save the file and close it. 
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3  Rename the existing security2.fdb 
In that same directory (C:\Program Files\Firebird\Firebird_2_1) you will find a file named security2.fdb. Rename 
this file to security2original.fdb. 
 

4  Copy over three files 
Now find the directory where you have installed the ACSAA software. If you haven't yet installed the ACSAA 
software, you may do it now. 
After the installation you will find two files which need to be copied into the "server directory" (C:\Program 
Files\Firebird\Firebird_2_1) from the following directory (C:\Program Files\ACSAA\ServerSetup) where you just 
edited and renamed the 2 files above. 

• security2.fdb  (C:\Program Files\ACSAA\ServerSetup) needs to be copied to the server installation directory 
(C:\Program Files\Firebird\Firebird_2_1). 

• acsaa.fdb  (C:\Documents and Settings\All Users\Application Data\ACSAA\CurrentData) needs to be copied 
to the directory you created as the alias. in step 2 above (C:\acsaadata\acsaa.fdb). 

• FreeUDFLib.dll needs to be copied to the server installation/udf directory (e.g. C:\Program 
Files\Firebird\Firebird_2_1\udf) which already exists. 

 
5  Re-start the server 
With all the previous steps now complete, in the control Panel applet used before, click the Start button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You have finished the customisations needed to make the Firebird server fully functional and easy to use with the 
ACSAA software. 
 

1.5.4  Testing your installation 
 

Now that the server has been installed, configured and is running again, it is time to test that everything is 
working correctly before you broadcast to users that they may connect to the new server. 
 
From another PC, i.e. not the PC on which you installed the server, and armed with the server name or its IP 
address, open a command box or DOS prompt. Ping the server as shown below. 
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If you get a response similar to the one show above, then you know that the network is running TCP/IP and that 
the server is visible over the network from the PC you are working on. If you do not get a response similar to the 
one above, then your network may not support the functionality you desire here. You may need to consult your 
network administrator. 
 

Assuming the correct response above, now telnet to the server on port 3050 as shown below 
 
 
 
 
 
 
 
 
 

This response confirms that Firebird is not running on the server. The response below proves that Firebird is 
indeed running on the server. 
 
 
 
 
 
 
 
 
 
An immediate answer from the server is rewarded by an open telnet session as seen in the title bar of the 
command window. There is nothing more Firebird can do via telnet. This is simply a test or communication. If 
there is a firewall present between the PC and the server, port 3050 may be blocked. In this case, you will need 
to adjust your firewall to permit traffic on port 3050. 
 
You may close the window now and start the ACSAA application software. If the PC you are sitting at does not 
have the ACSAA software loaded you will need to go to one which does have it installed or install it now. 
 
1.5.5 Connecting the ACSAA software 
 
Once the ACSAA application software is loaded, click on the Preferences button or select File/Preferences to view 
the screen show following: 
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During installation, the ACSAA software was installed as a standalone application but it still operates against a 
built or "embedded" firebird server. The alias you created in a previous step (see above) is already present in 
the default installation - see "Remote Database Path and Filename". 
 

Click on the "Use Remote Server" check box to enable the server name edit box. Once enabled, type the server 
name to which you wish to connect into the edit box as show above. 
 

When this is entered, click the "Test Connection" button. You will be warned that testing will begin so you may 
OK the next dialog. At this point you will be prompted to login to the remote server. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Type SYSDBA for the User, and masterkey (all lowercase) into the Password field. Press OK.  
If you have typed the user and passwords correctly,  
entered the servername correctly, and 
witnessed the successful tests above 
you will be rewarded by the dialog below 
 
 
 
 
 
 
 
 
Click OK to accept the changes. The application will ask you to login again to continue working at the server. 
Save the changes of the preferences and close the dialog. 
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At the bottom of the application window you should see the status bar as show below which confirms that 
you are working against the remote server instead of the local database. 
 
 
 
 
 
 
 
 
 
 
 
1.5.6  Creating users 
 

 
 
 
 
 
 
 
 
 

 Now it is time to create some users so that 
your staff can logon to the software under 
the appropriate roles provided for the cor-
rect use of the software. 
 
You'll notice that now you are connected to 
the remote server, the following menu 
items are enabled. 
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The SYSDBA user is the only user able to create new users. SYSDBA can log on to any desktop to create new 
users. All other uses are permitted to change their password and edit their personal details as show in the user 
dialog, but they cannot create new users. 
 
1.5.7 Setting up backup services 
 
To add a complete sense of security about the server setup, we must now consider the options for backing up 
the database at a regular interval. This will ensure that no data is lost due to hardware failure, network 
interruptions or software lockups etc, should they ever occur. 
 
At the IBPhoenix website, you will find several alternative methods outlined for backing up your databases. The 
standard tool for doing this is GBAK.exe and can be found in the bin directory of the server installation. If you 
choose, you may create simple batch files which execute gbak at regular intervals and thus make a regular 
backup of your database. The method outlined below is based on a tool to be supplied by ACSAA at no cost. 
The tool installs an additional service for the purpose of calling gbak on a scheduled basis, test the validity of 
the backup and additionally email/SMS a recipient when any error is detected in this process. 
 
The database file, in this case named "acsaa.fdb" is a file which is in exclusive use by the server engine. While 
the server engine is running, this file can be accessed at any time by a user with the correct permissions. As 
such, this file must be considered as constantly "live" and cannot be copied as you would copy any computer 
file. Backups must be done via the use of gbak. Backups using gbak are called "hot backups". They can be 
carried out at any time even when some one is currently working on the database. Use of gbak in this 
manner is the only safe way to backup the database. 
 
 

The green user symbol signifies that the user listed has 
been granted EDITOR status for the application.  
 
Click the Add User button to create a new user. Provide 
the necessary information in the fields shown and  
remember the password created. 
 
Right click on the role you wish to grant and select Grant 
this Role. Similarly, you may grant all roles, or revoke all 
roles in one operation. 
 
When you give this username and password to the  
respective users, they will be able to change the  
password to something of their liking once they login 
themselves. 
 
Don't forget to assign each user the appropriate Role. 
 
An EDITOR has permissions to edit any or all fields. 
 
A REVIEWER has permissions to read all the data but will 
be prevented from editing anything in the application. 
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Once the Services Control Centre has been installed 
start the applet and follow these setting  
recommendations: 
 
Select the Backup Restore Service as shown and edit 
the DefaultTaskSettings. 
 
Open The Backup settings and set the default Backup-
Folder. Backup tasks will be created in folders inside 
this directory They will be named to match the task 
name. Leave the other defaults as they are. 
 
 
 

 
 
 
 
 

Set the Restore Enabled option to True 
and the DeleteRestored option to True. If you ever 
wish to do a fresh backup restore cycle, you can tempo-
rarily set this option to False, but for normal operation, 
the restore is used to validate the database and can be 
deleted immediately after success. 

 
 

 
 
Leave the Pagesize option as the default 8192. 
 
Set the Compress Enabled option to True. 
Leave the default which uses a built-in zip compression 
on backups. 
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Database Settings 
If you have chosen to set an alias in the aliases.conf file on the 
server, you may use the alias here in the DatabaseName 
setting. If you have chosen a custom database name and do 
not wish to use aliases, then browse to the database file. Since 
you are setting this service up on the server itself, it is assumed 
that localhost is the server name. Refer to Configuring the 
Server for more information on this topic. 
 

Set the UserName and UserPassword. The installed default if 
SYSDBA and masterkey respectively. 
 
 
You must also ensure that GBakFile is set to the gbak 
executable. Use the ellipsis button to browse to: 
C:\Program Files\Firebird\Firebird_2_1
\bin\gbak.exe 
 
Mail Settings 
You are encouraged to set mail notification on to report by 
email when a baackup or restore operation has failed. 
Sometimes it is advisable to have the service report success as 
well. This can be treated as a heartbeat message. A missing 
email in the morning serves you more than never getting the 
failure alert and always wondering. 
 
Set the SMTP settings as you would with any email client. 
 
You may wish to increase the default RevolveBackupCount to 
10 to provide up to ten days of previous backups. This my 
prove helpful in the case of data rescue - see below. 
 
 
 
Schedule 
Click on the schedule and accept the default of every day at midnight as the desired operation time. 
The database can also be restored manually from this applet. It will be restored to another filename (other 
than the original). It is always recommended that you never overwrite the previous file. If restore is ever 
necessary, restore the file to another filename, then edit the aliases.config file as mentioned above to point to 
the new file. Stopping and starting the server will force the new alias to be read and from that point on, all 
users will be using this newly restored file. If you think there is any threat of people using the backup while 
you are doing the backup, first rename the database file on the server. This will ensure that no one uses it until 
you have completed the restore operation. 
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1.5.7.1  Adding your backup service 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Now that you have set the defaults, you must now create a backup task and schedule it. 
Right click on the Backup Service as shown and select "Add Task". 
 
A new "Task 0" will be visible. Click once and hold the mouse button on the "Task 0" title to change the name of 
this task. Edit the name as you wish or you can leave it if you want. 
 
Now double click the Active property or drop the selection and select Active. 
 
 
 
 
 

 
 
 
The backup job will now show as active with a coloured icon in the task list. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Now right click on the backup task and select "Run task immediately". You may need to confirm the saving of 
your changes and to confirm a re-start of the service for changes to take effect. 
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Select the service runtime info tab to display the running operation. If you have an error with the settings of 
the backup task you will see feedback conering the issue on this tab. 
 

When the task runs without error, you may exit the applet. Check your backup folder initially to ensure your 
backups are working and cycling correctly. 
 

1.5.8  Restoring from a previous backup 
 

There are two occasions when you may wish to restore from a backup. 
1   As part of routine possible annual maintenance cycle where you execute a backup and restore in a more or             
     less single operation, and 
2  As part of a data rescue plan when possibly data has been accidentally deleted and you wish to restore from     
      a previous day's backup file. 
 

1  Routine backup restore cycle 
Perhaps annually, you may wish to backup the database and restore it. This will re-establish indexes and  
re-build the data to provide a fresh copy of the database without previously deleted backup records. 
Simply set Restore/Settings/DeleteRestored property to False. 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
Then run the task immediately. The restored database will be found in the root folder of the declared backup 
folder. 
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Then rename the original database file to something like acsaaold.fdb and replace this with the restored copy. 
 

You must ensure that no one is working on the database from the time you start the backup until the time you 
replace the original. If you do not, then edits being made at the time will be left in the old version of the 
database. 
 

Ensure you return the DeleteRestored property to True after this operation and save and re-start the backup 
service. 
 

2. Data rescue from a backup 
Since you have a revolving backup cycle operating, it may be required to restore the database from a backup 
which is several days old. Unzip one of the backup files so that you have a .gbk file in a backup folder. 
At a DOS prompt the generic command for such an operation is: 
 
gbak.exe -r [options] source database 
 

This is expanded to look like this: 
 
"C:\Program Files\Firebird\Firebird_2_1\bin\gbak.exe" -r -user sysdba -pas masterkey 
"c:\Backups\2008.09.02_06.00.00\gbk_2008.09.02_06.00.00.gbk" 
"localhost:c:\acsaadata\newdatabfile.fdb" 
or another example might be: 
C:\Program Files\Firebird\Firebird_2_1\bin>gbak -r C:\Backups\Task1
\2008.09.02_10.13.09\1.gbk C:\acsaadata\newacsaa.fdb -user sysdba -pas masterkey 
This is showing the gbak being executed from the the bin directory. 
 

You will of course, need to change the names of the files and perhaps paths to match those of your environment. 
This command will restore the file to  
"c:\acsaadata\newdatabfile.fdb" 
 

You may now edit the aliases.conf file to contain this filename for the acsaa alias, or you may rename this file to 
the alias already listed in the aliases conf file. 
 
After either of the above operations are complete, it is recommended that you stop and re-start the 
Firebird service to ensure the changes are refreshed. 
 
1.5.9  Support resources 
 

Firebird Database Server has a large following with considerable and lively support offered by volunteers. Should 
you experience any problems during installation or operation, or simply wish to ask questions about Firebird, a 
Newsgroup is available where all are welcome. 
 

The starting point for Firebird knowledge is the IBPhoenix website at www.ibphoenix.com. From general 
information, development news, community links to a full range of downloads, both official and third party, it's all 
available here. There are also links to a range of support lists here. The Firebird Main Support List is the best 
starting point. This list is available via email (Yahoo Group) and is also visible via Newsreader software. 
 

A complete set of documents in .pdf format is also available for those in need of a comprehensive understanding 
of the server operations, API and Language references. A full library of documents can be found at the IBPhoenix 
website Firebird Documentation page. The documents are all called Interbase 6.0 Beta Documentation which is 
still current for all versions of Firebird. These sets of documents must then be read in conjunction with the 
Release Notes which have been installed with the Server installation doc directory. 
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1.6  Standalone Vs Network 
 

1.6.1  Moving your data file 
 

During software installation, the data file (acsaa.fdb) is installed into the application installation 
directory\CurrentData folder. If you wish to keep this file in a different directory, it can be moved. 
This file must me maintained on a local drive to the PC and NOT placed on a network share. Only one person 
at a time can get access to this file while the software is running in standalone mode. To permit simultaneous 
use of the data file by more than one user, a server must be installed for the purpose. See Server Setup for 
more details. 
 

To move your data file from it's default position to another position follow these steps: 
1 Open the software Preferences 
2 Select Saving & Backup tab 
3 Browse to a new backup directory 
4 Save and close the preferences 
 

Now backup (either the Backup toolbar button of File|Backup Database menu option) the open database (the 
one which is currently active),and select File|Restore Database menu option, which will require you to select 
the backup you made above. 
 

The database will be restored to the backup folder and the software will prompt you to connect to the restored 
database when it is finished restoring it. 
 

You are now connected to a copy of the database in it's new position. 
 

first backup your data file, then restore it, exit the application software and follow these steps: 
Copy acsaa.fdb to the new position (e.g. c:\mydata\acsaa.fdb). 
Open the file named aliases.conf file which will look like this: 
#  
# List of known database aliases  
# ------------------------------  
#  
# Examples:  
#  
#   dummy = c:\data\dummy.fdb  
#   
   acsaa = c:\Program Files\acsaa\currentdata\acsaa.fdb 
 

and edit it so that it lools like this 
 
#  
# List of known database aliases  
# ------------------------------  
#  
# Examples:  
#  
#   dummy = c:\data\dummy.fdb  
#   
   acsaa = c:\mydata\acsaa.fdb 

 
Save the file and stop and restart the server to force these changes to take effect. 

 
1.6.2  Network version 
 
The network version of this software is identical to the standalone version. By installing a centrally available 
server for all users to connect to, the software can be easily configured to use the remote server instead of the 
local copy of the database. 
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Refer to First Steps for setting up the server and configuring each desktop to use the remote database instead 
of the default local or desktop database copy. 
 
1.6.3  Standalone version 
 

The ACSAA Application software is installed, by default, as a standalone desktop version. In this version, all data 
is kept on a file named acsaa.fdb in the program directory\CurrentData folder. 
 

From a technical standpoint, the standalone version of the application uses the Embedded Firebird Server. 
 

1.6.4  Working with USB memory sticks 
 

It is possible to use USB memory sticks to move your data to and from home or another office. 
To avoid possible data corruptions, the following instructions need to be followed very carefully. 
 

USB memory sticks can only be used as a storage device for the data backup file.  
It cannot be used as the destination of your restored data. Or be used by setting the data directory 
setting of the application software to point to the USB device. Serious data corruption is almost 
certain in this case. 
 

Backing-up to USB  
Plug in your USB device and wait until windows has signalled that it is operating correctly. You may see an icon 
on the task tray which signals the device as ready. Or you may see windows explorer open and listing the files 
which are on the device. 
 

 
 
 
 
 
 
Once this is apparent, open the 

Preferences and select the Saving & Backup tab. 
Select the Backup Directory selector and browse to and select the device drive letter. It is often G: but may be 
any assignment depending on other devices you may have present. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
With the setting saved in Preferences, select File/Backup from the main menu. The normal backup process will 
now take place and store the backup file onto the USB device. 
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Ensure you use the correct (safe) ejection method for the device before you remove it from the 
USB port. 
Restoring from USB 
On the PC where you wish to restore the database, insert the USB and again , set the Backup directory in the 
ACSAA application to the USB drive letter. 
Now choose File|Restore from the main menu. The open backup will open showing the contents of the USB 
drive. Select the fbk file you created previously and click Open. 
The database will now be restored from the USB into your PCs local database path folder which is also set in 
the Preferences. You will be prompted to switch to the restored file when the restore operation completes. 
 
Further Backup and Restore cycles can be achieved in the same manner. 
 

1.7  Printing 
 

At any time during input to your application, you may choose to print the administrative information, answers 
for a single expected outcome or all the expected outcomes.  
 
Select the Reports menu for these options.  
 
The application checklist can be printed separately.  
 
Printing any or all of the application is not necessary for submission of the application. Submission of the 
application should be done via email after selecting File|Submit Application.  
 

1.8  Data backup 
 

Data is contained in a single file which ends in the extension '.fdb.' This file extension is not necessary but 
some alternatives (e.g. gdb) will cause connection delays on some operating systems. This file is located by 
default in the program install directory of the software, e.g. 'C:\Program Files\ACSAA' is the default directory.  
 
Do NOT move or copy this file using the operating system copy command. Instead, use the backup and 
restore options provided to backup the database, move or copy this backup to an alternative disk position then 
restore this backup file into the database position of choice. Once restored, open the software and use the 
software preferences to connect to this database. 
 
It is also possible to export an answer set (application) then import this exported answer set to another active 
database. This imported answer set will appear as a separate application in the application browser. 
 
If you wish to backup your data on a regular basis, use the backup toolbar button to backup the database. If 
you have a mapped network drive, backups can be directed to this drive making it possible to include a backup 
of your application in your normal system backup routines. Backing up the non-transportable version of the 
database (i.e. .fdb file) is not recommended. 
 
Do NOT place the database file on a path which is visible to a streaming tape or arcserver type 
backup server. The database file used for this software will corrupt if copied while users have active 
connections to it. 
 
The backup facility offered to the desktop or standalone version of the software is not available from the 
desktop when the software is used on multi-user (network) mode. The task of backing up is carried out at the 
server in this situation and must be established by the system administrator. See Setting up backup services 
for more details. 
 
Auto backup: When this option is set in the Preferences, each time you exit the application software, all data 
is backed up. You may also manually backup the data at any time. 
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1.9  View Menu 
 
1.9.1  Provider details 
 

At any time during the editing of text in the self-assessment detail or summary view, you may open the 
Provider Details form for editing. 
 

There are five tabbed pages with questions regarding the Provider and Delegate details. 
 

Make sure you complete the core questions marked with a red asterisk. Application submission will not be 
possible if core questions are left unanswered. 
 

Payment must be made per individual home. Please ensure the RACS ID is your bank payment reference. 
Without that identification we cannot match electronic payments. 
 

Save your edits by clicking the "Save & Close" button or cancel your edits by clicking the "Cancel" button. 
 

1.9.1.1  Contact for correspondence 
 

This is the person who will receive all correspondence, notifications and enquiries concerning the home 
including education, seminars, setting up of visits, and reports about the performance of the home against 
the Accreditation Standards.  
 

Tick the appropriate boxes to use previously entered addresses for provider or home address.  
Tick the appropriate box if the person is from a Management Company and fill in the postal address of that 
person. 
 

1.9.1.2  Other homes 
 

Do you have more than one residential aged care home for which you have an allocation of places? If “YES,” 
the grid will become enabled. If you select “NO”, the grid will become disabled and no editing can take place.  
 

To create more lines for adding more homes, simply click on the grid and use the down arrow button or tab 
across. Enter text into each new line.  
 

Right click on the grid area and select "Delete line" to remove a line if required. 
 
1.9.1.3  Payment details 
 
Payment must be made per individual home. Please ensure the RACS ID is your bank payment reference. 
Without that identification we cannot match electronic payments.  
 
Accreditation fees are described in the fee schedule in the Accreditation GrantPrinciples 1999 as amended,  
25 June 2004. As of 1 July 2004 the fee schedule is subject to CPI increases. 
 
You are required to pay for all allocated places whether you are providing care for them or not. You do not 
have to pay for provisional allocation. 
 
 
1.9.1.4  Approved provider declaration 
 
Please declare authority to submit the application and manually type the date of the declaration. 
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1.9.2  Details of home 
 

At any time during the editing of text in the self-assessment detail or summary view, you may open the Details 
of home form for editing. 
 
There are six tabbed pages with questions regarding the home, allocated places, specialised and other services 
on the same site and other accreditations and personal notes. 
 
The note field on the Notes tab is for private use. It is NOT forwarded to the Agency and DOES NOT form any 
part of your application. This field is intended to help manage the applications or versions of the applications 
created with this software. 
 
Make sure you complete the core questions marked with a red asterisk. Application submission will not be 
possible if core questions are left unanswered. 
 

Save your edits by clicking the "Save and Close" button or cancel your edits by clicking the "Cancel" button. 
 
1.9.2.1  Details of places available 
 
The following fields are compulsory: 

• Allocated places 
• Total number of residents 
• Number of residents receiving high and low care 

 
Please also indicate if new provisional allocations are being readied for admission and the date they will be 
considered as no longer provisional. 
 
You are required to pay for all allocated places whether you are providing care for them or not. You do not 
have to pay for provisional allocation. 
 
1.9.2.2  Specialised services 
 
Answering "YES" to whether there providing specialised health services enables the speciality grid . Answering 
"NO" disables the grid. 
 

To create more lines for adding more homes, simply click on the grid and use the down arrow button or tab 
across. Enter text into each new line. 
 

Right click on the grid area and select "Delete line" to remove a line if required. 
 

Answering "YES" to whether there providing specialised cultural services enables the speciality grid .Answering 
"NO" disables the grid. 
 

To create more lines for adding more homes, simply click on the grid and use the down arrow button or tab 
across. Enter text into each new line. 
 

Right click on the grid area and select "Delete line" to remove a line if required. 
 
1.9.2.3  Other services 
 
Answering "YES" to whether there are any other residential aged care services with separate RACS ID at the 
same location enables the "Name of home" grid. Answering "NO" disables the grid. 
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Enter each home with the associated RACS ID, one per line.  
 
To create more lines for adding more homes, simply click on the grid and use the down arrow button or tab 
across. Enter text into each new line. 
 

Right click on the grid area and select "Delete line" to remove a line if required.  
 

Answering “YES” to whether there are other services such as childcare enables the other services provided grid. 
Answering “NO” disables the grid. 
 

Enter each service, one per line.  
 

To create more lines for adding more homes, simply click on the grid and use the down arrow button or tab 
across. Enter text into each new line. 
 

Right click on the grid area and select "Delete line" to remove a line if required.  
 

1.9.2.4  Other accreditations 
 

Is the home accredited with any organisations other than the Aged Care Standards and Accreditation Agency Ltd 
eg ISO, HACCP? 
Please list any/all accreditations you consider relevant to your application. 
The field is free text and does not have to comply with any layout rules. 
 
1.9.2.5. Notes 
 

This field is for private use. It is NOT forwarded to the Agency and DOES NOT form any part of your application. 
This field is intended to help manage the applications or versions of the applications created with this software. 
 

Keep notes about what is left to do or what has been delegated. Other users can contribute to these notes as 
the application progresses. 
 

You will notice that if you export the application, then import it to copy the data, the notes field will not import 
into the new copy.  
 

1.9.3  Nomination of quality assessors 
 

This is an optional form. There is no requirement to nominate quality assessors. 
 

At any time during the editing of text in the self-assessment detail or summary view, you may open the 
Nomination of quality assessors form for editing.  
 

There is one tabbed page where three assessors may be nominated. You may wish to nominate a quality 
assessor to conduct the audit of your service. If so, please list in order of preference the names of up to three 
(3) registered aged care quality assessors. Please contact us to check if a person is registered  by calling   
02 9633 1711. 
 
1.9.4  Self-assessment 
 

Standards and expected outcomes can be navigated by expanding a Standard (double or single clicking it 
depending on your PC settings) then clicking on an expected outcome, or you can choose the Previous or Next 
Buttons on the Toolbar (at the top of the screen) or just use the up/down arrow keys to move the focus up and 
down the expected outcomes. You will notice the expected outcome headings change according to your 
selection.  
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1.9.5  Self-assessment summary 
 

The Self-assessment summary view provides a summary of your responses to the expected outcome "achieve" 
question.  
 
Selecting the View menu, then the Self-assessment summary menu item brings up the summary of ratings. 
Making a selection in the View menu allows you to return to another area of the application. 
 

1.9.6  Application Browser 
 

 
 
 
By default the prompts are visible on the left under the standards and expected outcome navigation tree. The 
help menu and view menu both have menu items which make the question prompts disappear and appear 
(turn on/off). When the question prompts are turned off, the application browser is visible. When the prompts 
are turned on, the application browser is not visible. 
 

When an application has been submitted, the application is marked with a red bar. Subsequent attempts at 
submitting (exporting) the application will be met with a warning that the application has already been 
submitted. If re-submission is required, simply right click on the application in the application browser and 
select "Toggle Submitted Status" to remove the red bar and permit re-submission. 
 

You can also create a new application through the Application Browser .Right click  on the Application Browser 
panel and select ‘New application’. You then have a blank form. To create it as another home ensure you enter 
the RACS id and save. 
 

1.9.7  Question prompts 
 

Question prompts have been provided to assist in compiling your application. 
 
By default the prompts are visible on the left under the standards navigation tree. The help menu and view 
menu both have menu items which make the question prompts disappear and appear (turn on/off). When the 
question prompts are turned off, the application browser is visible. When the prompts are turned on, the 
application browser is not visible. 
 
 
 
 

The software provides for multiple simultaneous  
applications. For providers who wish to manage several  
applications at one time, the Application browser is a means 
of switching between applications. 
 
Selecting View/Application Browser hides the question 
prompts to reveal a grid of applications and RACS ID  
numbers. Viewing the Question Prompts will hide this 
browser and reveal the prompts instead. 
 
Access to these alternative views is possible via both the 
View menu and the Help menu. 
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1.10  Data entry 
 
Data may be entered into any text box in any sequence. The View menu provides a sequential list of data entry 
requirements, but this sequence need not be followed. The list is offered as a memory jog for the areas 
requiring completion.  
 

When entering data in the text boxes, most word processing functions such as bold, italics and bullets are 
available. 
 

Once applicants fill in core questions about home and provider details the View menu selections are shown as 
checked. This does not mean you have necessarily completed these sections and you may still edit these areas 
at a later time.  
 
1.11  Spell check 
 
 
 
 
 
 
 
The Software provides spell-checking options for answers to expected outcomes. The Spelling Checker  
is on all the time and as you type, misspelled words are highlighted by a red squiggly underlining.  
 
You can customise the spell check by selecting spell check options. An auto correct function is not provided with 
this system. 
 
Note: you cannot do a global spell check. The spell check function only applies to the text box you are working 
in. 
 
1.12  Saving your work 
 

The Software automatically saves your work at 5 minutes intervals by default. This interval can be changed in 
the software preferences. If you wish, you may save your work manually by selecting the File / Save Edits.  
 
You may also save your work by clicking on the Save Edits toolbar button or using the speed key combination or 
Ctrl+S. 
 
In the standalone version when exiting from the software, a backup of the dataset is made in the Data backup 
directory if this preference setting is selected. See the Data Backup section for more details. 
 
1.13  Required fields 
There are number of compulsory fields in the Application. These fields are marked with a red asterisk * Before 
exporting (preparing to submit) your application, the software will check that these questions have been 
answered. 
 
The question appearing at the bottom of each expected outcome is not compulsory. 
"The information above demonstrates that we achieve this expected outcome." 
 
You will, however, be warned when the response to all 39 expected outcomes is "we do not achieve". This is to 
avoid the possibility that the applicant has omitted to answer this question. 
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1.14  Answer check 
 

Before a successful export can take place, the software checks all compulsory answers to ensure they have been 
filled in. 
 

If there are more than 15 compulsory questions left unanswered, a message will be displayed letting you know. 
The application should be revisited to ensure all required fields have been answered. If less than 15 questions are 
yet to be answered, a list of the fifteen questions and the origin of the question is displayed. E.g. Details of home 
– RACSID. You have to open the Details of home dialog and answer the question before export can take place. 
 

If all expected outcomes are marked to show your home does not achieve the expected outcome, you will be 
warned during answer checking and submitting. 
 

1.15  Application submission 
 

E-mail submission  
 

Use the File|Submit Application menu option for submission of your application. This function will carry out an 
Answer check, then, if there are not missing Required fields, will create the export file ready for email submission. 
The application is then marked as submitted in the Application browser. Further attempts to submit the 
application will receive a warning about having already made a submission. 
 

Start your e-mail software and address your e-mail to the Agency e-mail address for your local office which can 
be found on the website at http://www.accreditation.org.au and in the Accreditation Guide. Or click here to start 
your email software. 
 

Enter the appropriate email address for your state. Refer to email address listing. 
 

Now insert an attachment by selecting the .zip file as your attachment. 
nsw_act@accreditation.org.au 
vic_tas@accreditation.org.au 
sa_nt@accreditation.org.au 
queensland@accreditation.org.au 
wa@accreditation.org.au 
 

You may now send the email. 
 

Postal submission  
Insert a CD in the CD drive Using Windows explorer, copy the exported application to the empty disk. 
 

You may now package the disk for postal submission. 
 

1.16  Exporting and importing applications 
 
It is possible to export an application for the purpose of: 

• Backing up the data, 
• Re-importing the application and thus copying it 

 
Do not use the export function for the purpose of generating a copy for application submission. 
There is no answer checking function associated with the export function. See Application Submission for details 
answer checking and support documents. 
 

It is possible to re-open/import exported answer sets. Select the File/Import application menu item.  
 
When an exported file is imported, it creates a new application in the current database. 
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This feature presents several possibilities in the process of completing the application. 
 
For example, you can archive the answer set and email it to a colleague to continue with expected outcomes 
which you may need them to complete. They can complete them and return the answer set. 
 
You may wish to create a 'template' answer set and distribute the set with provider and service details 
completed to colleagues, or save this template for later. 
 
1.17  Sources of help 
 

The Software comes with three forms of help systems.  
 
This help file is one form. It contains software help and help about applying for accreditation. This cab be 
accessed via the Help menu 
 

Another form of help is the Startup Tips. These are short notes and reminders to help get the most out of the 
Software and make the application process as simple and efficient as possible.  The Tips only show once each 
time you start the Software. To turn these startup tips off at anytime, go to the Help menu, 'Show Startup Tips' 
and click. 
 

To stop the tips you may uncheck the 'Show Tips at Startup' on the tips page when the Software starts. To 
start the tips again, select the 'Show Startup Tips' menu item from the Help menu. The next time you start the 
Software, the tips will pop-up. 
 

See also, Question Prompts. 
 

1.18  Question Prompts 
 

Under the Standards navigation panel, which always remains visible while navigating expected outcomes  
(see Self-assessment Summary View), are two question prompt panels. The content of these panels changes 
depending on the expected outcome question you are answering.  
 

One is the Self-assessment prompts and the other is called "Think about". 
 

These panels may be hidden from view by selecting Help / Question Prompts from the main menu. 
 

The Software will remember that you have turned on/off these prompts and will not show them until you turn 
them back on. 
 

The splitter bars, which separate the prompts from the Standards Navigator and the two different prompt 
areas, can be moved to your preferred position. The Software will remember this position between sessions. 
 

See Sources of Help for more information on Startup tips. 
 

1.19  Updates 
 

Software updates are available from http://www.accreditation.org.au 
 

You may choose to download the entire package, updates to the Software, or amended help files. You will be 
notified of updates when they become available through the newsletter, and by notices on the website. 
 
To check if a particular update is applicable, compare the exact version number of your Software (found on the 
Help / About screen - e.g. Version 2.3.12.3) and the version published on the website as the most recent build. 
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1.20  File upgrades 
 
In some instances, a new software version will require to upgrade the data fields from a previous version. This is 
done when new fields are added or changed in the data structure of the software.  
 
Each time the software is started a check is carried out on the data structure and if the version of the data files 
has been superseded, it will be transferred to the new structure.  
 
When a new version is distributed and you are using the network version of the software, it is vital that one 
person only carries out the initial installation of the new version. Upgrades to the database will occur upon initial 
starting of the new version. Subsequent installations of the software will not have any effect. However, once a 
new version of the software is installed, older version of the software will refuse to load and operate. When this 
happens it will be necessary to reinstall the new version to each and every PC which requires connection to the 
server. 
 
Upgrades of this nature will be separately accompanied by detailed instructions which re-iterate these steps. 
 
 
 
1.21  Export error codes 
 
The following error codes may be presented to the user during export and application submission. For example, 
error 240 indicates that the zip Dlls are missing from the installation. 
 
Value Error code 
 
0 XcdSuccess 
10 XcdWarningGeneral 
30 XcdWarningNoZipFile 
40 XcdWarningFilesSkipped 
100 XcdErrorNoZipFile 
110 XcdErrorZipStruct 
120 XcdErrorMemory 
130 XcdErrorBadCall 
140 XcdErrorNothingToDo 
150 XcdErrorDiskFull 
160 XcdErrorEOF 
180 XcdErrorLibInUse 
190 XcdErrorUserAbort 
200 XcdErrorTestFailed 
210 XcdErrorZeroTested 
240 XcdErrorDLLNotFound 
250 XcdErrorInternalLogic 
280 XcdErrorTempFile 
350 XcdErrorParentDir 
370 XcdErrorNameRepeat 
 
380 XcdErrorLatest 
400 XcdErrorDOSError 
410 XcdErrorMultidisk 
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2  Application help 
 

2.1  How do you complete an application for accreditation? 
 
The application may be completed in any order. However, to save your work you must have entered the 
RACS ID. 
 

1 Complete a self-assessment of the service. This should provide you with information about your 
achievements concerning the Accreditation Standards. 

2 Complete the approved provider and service details and nominate up to three assessors if you wish. 
3 Enter the information that shows what you achieved in relation to each of the expected outcomes and 

your overall approach to each of the Standards. 
4 Check the circle down the bottom of each expected outcome screen to acknowledge whether or not 

you have achieved the expected outcomes. 
5 Decide if there are improvements the home plans to make and enter that information under 

Continuous improvement 1.1, 2.1, 3.1 4.1. 
6 Calculate and arrange the payment of the accreditation fee. 
7 Export the service's electronic application (see Export in the Help file for further instructions). 
8 E-mail the exported file to your local Agency office. If you cannot e-mail the application, you may save 

the exported file to a compact disk and post to your local Agency. 
9 If paying by electronic funds transfer, ensure that the funds have been transferred by the time the 

Agency receives your application.  
 

There is a checklist for the application under the Reports menu. 
 

2.2  What additional documents are required? 
 
The home is required to make available the following documents at the commencement of, and during, the 
site audit: 
 

1 The home's vision, values, philosophy, objectives and commitment to quality (Expected Outcome 1.5). 
2 Information provided to residents at the time of entry (eg resident handbook, leaflets etc). 
3 A list of names and relevant positions of the key staff with whom the assessment team will liaise for 

assessing individual outcomes throughout the audit. 
4 Site plan (eg plan given to residents or staff to orientate themselves to the buildings or a fire 

evacuation diagram showing the position of the building or buildings). 
 

2.3  What is the purpose of this application? 
 
The purpose of this application is to enable the approved provider (or the delegate of the approved provider) 
to apply for accreditation of a residential aged care home after completing a self-assessment exercise. 
 

Approved providers must make application for accreditation using this electronic format or the paper copy. 
 

2.4  What information is available about accreditation? 
 
There is a series of fact sheets on the Agency's web site www.accreditation.org.au setting out the 
accreditation process. 
 

The fact sheets are a guide to accreditation for residential aged care homes. You should read these fact 
sheets before filling in your application. 
 

More detailed information about accreditation of residential aged care homes can be found in the 
Accreditation Grant Principles 1999 and the Aged Care Act 1997. 
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2.5  Who should submit the application? 
 
The approved provider of the residential aged care service must submit the application. The approved provider is 
the person or body approved by the Secretary of the Department of Health and Ageing as a provider of 
residential aged care. 
 
Sections of the application may be completed by others delegated by the approved provider.  
However, the Approved Provider Declaration must be completed by the individual who has been approved as a 
provider of residential aged care for the service, or where the approved provider is not an individual by the 
delegate appointed by the approved provider. 
 

2.6  What is a valid application? 
 
A valid application is one that: 
• Is made by the approved provider 
• Uses the approved Agency application form (either electronic or paper copy) 
• Has all parts of the application form completed 
• Includes the agreement by the approved provider that the service will undertake continuous improvement has 

had the correct accreditation fee paid 
 

2.7  When should an approved provider apply for accreditation? 
 
Under the Aged Care Act 1997 all residential aged care homes must be accredited to be eligible to receive 
Commonwealth residential care subsidies. 
 

Homes that are due for re-accreditation must apply by the date previously advised by the Agency. This date is 
usually six months before their current accreditation period expires. 
 

Approved providers intending to open a commencing service should look at the Agency's web site 
www.accreditation.org.au for further information. 
 

2.8  What level of confidentiality applies? 
 
All information supplied to the Agency is treated confidentially and is used only for the purpose of accreditation 
and other responsibilities of the Agency as outlined in the Accreditation Grant Principles 1999. 
 

Personal information (such as the approved provider delegate name or service contact name) is used only for the 
purposes of processing the application for accreditation and for maintaining contact throughout the period of 
accreditation. 
 

2.9  How much does accreditation cost? 
 
Accreditation fees are described in the fee schedule in the Accreditation Grant Principles 1999 as amended,  
25 June 2004. As of 1 July 2004 the fee schedule is subject to CPI increases.  
 

Payment can be by electronic funds transfer or by cheque. Whichever form of payment is chosen, the payment 
must be made per individual home and you must quote the home's RACS ID as your reference. The RACS ID is 
the four digit Residential Aged Care Service Identification Number allocated to the home by the Department of 
Health and Aged Care. The RACS ID is the bank payment reference number that should be used in forwarding 
payment to the Agency's account. 
 
If paying by electronic funds transfer, please follow the procedure determined by your financial institution using 
the following Agency information. 
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• Bank: Commonwealth Bank of Australia 
• Branch: Parramatta  
• BSB Number: 062441 
• Bank Account Number: 10048559 

 
 
Please make cheques payable to the Aged Care Standards and Accreditation Agency with the RACS ID printed 
on the reverse of the cheque. The inclusion of the RACS ID assists the Agency to track the cheques against each 
home. 
 
The fees for accreditation are described in the fee ready reckoner available on the Agency's web site.  
The approved provider must pay for all allocated places whether occupied or not. 
 
 
 
2.10 How does an approved provider apply for accreditation of a 
commencing service? 
 
A commencing home is one where an approved provider has been allocated places to be used in the home and 
those places have not been previously used for residential aged care. A commencing home must be accredited 
to qualify for Commonwealth residential care subsidies and before it can admit residents. 
 
Approved providers intending to operate a commencing home should contact the Agency at least three months 
before the date they plan to admit residents. The local office can then discuss an appropriate application date 
for the proposed home. 
 
The commencing home application is available on the Agency web site www.accreditation.org.au. 
 
 
 
2.11 What are the Agency e-mail contacts? 
 

 
nsw_act@accreditation.org.au 
vic_tas@accreditation.org.au 
sa_nt@accreditation.org.au 
queensland@accreditation.org.au 
wa@accreditation.org.au 
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